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Overview


Introduction

This is a handbook for ARC labs which is a part of ARC university courses.
The handbook is written to help students who attend the ARC university course.
Anyone interested in DesignWare® ARC® processors can also take this handbook as a quick start-up to get started in DesignWare® ARC® processors development.
In this handbook, all the basic elements of ARC are described in the labs with a step-by-step approach.

This handbook can be used as a Lab teaching material for ARC university courses at
undergraduate or graduate level with majors in Computer Science, Computer
Engineering, Electrical Engineering, or for professional engineers.

This handbook includes a series of labs (more labs will be added in the future), which are roughly classified into 3 levels:


	Level 1: ARC basic




The labs in this level cover the basic topics of DesignWare® ARC® processors. For example, the
installation and usage of hardware and software tools, software or hardware
development kits, the first hello world example, interrupt handling and internal timers of DesignWare® ARC® processors, and so on.


	Level 2: ARC advanced




The labs in this level cover the advanced topics of DesignWare® ARC® processors. For example,
Real-Time Operating System (RTOS), customized linkage, compiler optimization,
basic applications, DesignWare® ARC® processors DSP feature, and so on.


	Level 3: ARC exploration




The labs in this level cover some complex applications of DesignWare® ARC® processors. For example,
Internet of Things (IoT) application, embedded machine learning, and so on.

Most of the labs are based on the embARC Open Software Platform (OSP) [https://github.com/foss-for-synopsys-dwc-arc-processors/embarc_osp] which is an open
software platform to facilitate the development of embedded systems based on
DesignWare® ARC® processors.

It is designed to provide a unified platform for DesignWare® ARC® processors users by defining
consistent and simple software interfaces to the processor and peripherals
together with ports of several well known Free and open-source software (FOSS)
embedded software stacks to DesignWare® ARC® processors.

For more details about embARC OSP, please see its
online docs [http://embarc.org/embarc_osp/].



Supported Hardware Platform

The following DesignWare® ARC® processors based hardware platforms are supported in this handbook.



	ARC EM Starter Kit [https://www.synopsys.com/dw/ipdir.php?ds=arc_em_starter_kit]


	ARC IoT Development Kit [https://www.synopsys.com/dw/ipdir.php?ds=arc_iot_development_kit]







You can click the above links to get the platform’s data sheet and user
manual as a reference.



Reference



	Item

	Name





	1

	ARC EM Databook



	2

	MetaWare docs



	3

	ARC EM Starter Kit User Guide



	4

	ARC GNU docs










          

      

      

    

  

    
      
          
            
  
Getting Started

Use this guide to get started with your ARC labs development.


Software Requirement


	
	ARC Development Tools [https://www.synopsys.com/designware-ip/processor-solutions/arc-processors/arc-development-tools.html]

	Select MetaWare Development Toolkit or GNU Toolchain for ARC Processors from the following list according to your requirement.






	MetaWare Development Toolkit


	Premium MetaWare Development Toolkit (2018.06) [https://www.synopsys.com/dw/ipdir.php?ds=sw_metaware].
The DesignWare ARC MetaWare Development Toolkit builds upon a 25-year legacy of industry-leading compiler and debugger products. It is a complete solution that contains all the components needed to support the development, debugging, and tuning of embedded applications for the DesignWare ARC processors.


	DesignWare ARC MetaWare Toolkit Lite (2018.06) [https://www.synopsys.com/dw/ipdir.php?ds=sw_metaware].
A demonstration or evaluation version of the MetaWare Development Toolkit is available for free from the Synopsys website. MetaWare Lite is a functioning demonstration of the MetaWare Development Toolkit with restrictions such as code-size limit of 32 Kilobytes and no runtime library sources. It is available for Microsoft Windows only.






	GNU Toolchain for ARC Processors


	Open Source ARC GNU IDE (2018.03) [https://github.com/foss-for-synopsys-dwc-arc-processors/toolchain/releases].
The GNU Toolchain for ARC Processors offers all of the benefits of open source tools such as complete source code and a large install base. The ARC GNU IDE Installer consists of Eclipse IDE with ARC GNU plugin for Eclipse [https://github.com/foss-for-synopsys-dwc-arc-processors/arc_gnu_eclipse/releases], ARC GNU prebuilt toolchain [https://github.com/foss-for-synopsys-dwc-arc-processors/toolchain/releases], and OpenOCD for ARC [https://github.com/foss-for-synopsys-dwc-arc-processors/openocd].










	Digilent Adept Software [https://store.digilentinc.com/digilent-adept-2-download-only/] for Digilent JTAG-USB cable driver. All the supported boards are equipped with on board USB-JTAG debugger. One USB cable is required and external debugger is not required.


	Tera Term [http://ttssh2.osdn.jp/] or PuTTY [https://www.putty.org/] for serial terminal connection. The serial configurations are 115200 baud, 8 bits data, 1 stop bit, and no parity (115200-8-N-1) by default.





Note

If using embARC with GNU toolchain on Windows, please install Zadig [http://zadig.akeo.ie] to replace FTDI driver with WinUSB driver. See How to Use OpenOCD on Windows [https://github.com/foss-for-synopsys-dwc-arc-processors/arc_gnu_eclipse/wiki/How-to-Use-OpenOCD-on-Windows] for more information. If you want to switch back to Metaware toolchain, make sure you switch back the usb-jtag driver from WinUSB to FTDI driver.
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Hands-on labs



	Basic labs
	How to use ARC IDE

	How to use embARC OSP

	How to use ARC board

	ARC features: AUX registers and timers

	ARC features: Interrupts

	A simple bootloader





	Advanced labs
	Memory map and linker

	A WiFi temperature monitor

	BLE Communication

	How to use FreeRTOS

	ARC DSP: Compiler Optimizations

	ARC DSP: Using FXAPI

	ARC DSP: Using DSP Library





	Exploration
	AWS IoT Smarthome
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Basic labs



	How to use ARC IDE

	How to use embARC OSP

	How to use ARC board

	ARC features: AUX registers and timers

	ARC features: Interrupts

	A simple bootloader
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How to use ARC IDE


MetaWare Development Toolkit


Purpose


	To learn MetaWare Development Toolkit


	To get familiar with the basic usage of the MetaWare Development Toolkit


	To get familiar with the features and usage of the MetaWare Debugger (mdb)






Requirements

The following hardware and tools are required:


	PC host


	MetaWare Development Toolkit


	nSIM simulator or ARC board (EM Starter Kit / IoT Development Kit)


	embarc_osp/arc_labs/labs/lab_core_test






Content


	Create a C project using the MetaWare Development Toolkit


	Import the code CoreTest.c from embarc_osp/arc_labs/labs/lab_core_test


	Configure compilation options to compile, and generate executable files.


	Start the debugger of MetaWare Development Toolkit and enter debug mode.




From two different perspectives of C language and assembly language, use the methods of setting breakpoint, single-step execution, full-speed executions, etc., combined with observing PC address, register status, global variable status, and profiling performance to analyze and debug the target program.



Principles

Use the MetaWare Development Toolkit to create projects and load code. In the engineering unit, configure the compilation options to compile code, debug, and analyze the compiled executable file.

Routine code CoreTest.c:

/////////////////////////////////////////////////////////////////////////
// This small demo program finds the data point that is the
// minimal distance from x and y [here arbitrarily defined to be (4,5)]
//
// #define/undefine '_DEBUG' precompiler variable to obtain
// desired functionality. Including _DEBUG will bring in the
// I/O library to print results of the search.
//
// For purposes of simplicity, the data points used in the computations
// are hardcoded into the POINTX and POINTY constant values below
/////////////////////////////////////////////////////////////////////////


#ifdef _DEBUG
#include "stdio.h"
#endif

#define POINTX {1, 2, 3, 4,  5,  6,  7,  8,  9, 10}
#define POINTY {2, 4, 6, 8, 10, 12, 14, 16, 18, 20}
#define POINTS 10

#define GetError(x, y, Px, Py) \
    ( (x-Px)*(x-Px) + (y-Py)*(y-Py) )

int main(int argc, char* argv[]) {
    int pPointX[] = POINTX;
    int pPointY[] = POINTY;

    int x, y;
    int index, error, minindex, minerror;

    x = 4;
    y = 5;

    minerror = GetError(x, y, pPointX[0], pPointY[0]);
    minindex = 0;

    for(index = 1; index < POINTS; index++) {
            error = GetError(x, y, pPointX[index], pPointY[index]);

            if (error < minerror) {
                    minerror = error;
                    minindex = index;
            }
        }

#ifdef _DEBUG
    printf("minindex = %d, minerror = %d.\n", minindex, minerror);
    printf("The point is (%d, %d).\n", pPointX[minindex], pPointY[minindex]);
    getchar();
#endif

    return 0;
    }







Steps


	Create a project




Open the MetaWare Development Toolkit, create an empty project called demo, and select the ARC EM Generic processor.

[image: figure1]


	Import the code file CoreTest.c to the project demo.




In the Project Explorer, click [image: icon1] and select Import.

In the Implort wizard, select File system from the General tab, then click Next. As shown in the following figure, in the From directory fileld, type or browse to select the directory contain the file CoreTest.c. Recent directories that have been imported from are shown on the From directory field’s combo box. In the left pane, check a folder that will import its entire contents into the Workbench, and in the right pane check the file CoreTest.c.

[image: figure2]

Click Finish when done, the file CoreTest.c is now shown in the one of the navigation views in the project demo.


	Set compilation options




From the Project Explorer view, right-click the project demo and choose Properties. Click C/C++ Build > Settings > Tool Settings menu options.
The Tool Settings dialog opens.

[image: figure3]

Select Optimization/Debugging to set the compiler
optimization and debugging level. For example, set the optimization level to
turn off optimization, and set the debugging level to load all debugging
information.

Select Processor/Extensions to set the compilation options corresponding to the target processor hardware properties, such as the
version of the processor, whether to support extended instructions such as
shift, multiplication, floating-point operations, and so on whether to include
Timer0/1. As shown in the following figure, this setting indicates that the target
processor supports common extended instructions.

[image: figure4]

Select MetaWare ARC EM C/C++ and check the settings compilation options. Click OK when done.


	Build project




In the Project Explorer view, select project demo.
Click Project > Build Project or click the icon [image: icon2] on the toolbar.
In the MetaWare Development Toolkit main interface, you can see in the Console view the output and results of the build command. Click on its tab to bring the view forward if it is not currently visible. If for some reason it’s not present, you can open it by selecting Window > Show View > Console. When the message Finished building target: demo.elf is displayed, the compilation is successful, and the compiled executable file demo.elf can be seen in the Project Explorer.

[image: figure5]


	Set debug options




Click the Run > Debug Configurations… menu option to open the Debug Configurations dialog.
Double-click C/C++ Application or right-click New to create a new launch configuration.

[image: figure6]

If a project is selected in the Project Explorer view all data is automatically entered, take a moment to verify its accuracy or change as needed. Here you do not need to make any changes, just click Debug to enter the debugging interface.


	Debug executable file demo.elf




You may be prompted to switch to the Debug perspective. Click Yes.

The Debug perspective appears with the required windows open. And the windows can be source code window, assembly code window, register window, global variable window, breakpoint window, function window, and so on.

[image: figure7]

In the C code window, right-click the code line number on the left side of the window, select Toggle Breakpoint or double-click the line number to set a breakpoint on. In the assembly code window, double-click a line of code to set a breakpoint on. You’ll see a blue circle there indicating the breakpoint is set.

After the breakpoint is set, click Run > Resume or you can use the Resume button [image: icon3] on the toolbar of the Debug view to run the program. The program runs directly to the nearest breakpoint. You can observe the current program execution and the relevant status information of the processor through the various windows as described in previous step. If you want to know more about the details of program execution and the instruction behavior of the processor, you can use the following three execution commands [image: icon4] to perform single-step debugging. The icon [image: icon5] can choose to step through a C language statement or an assembly instruction to match the status information of each window. It can be very convenient for program debugging. If you want to end the current debugging process, click [image: icon6]. If you want to return to the main MetaWare Development Toolkit page, click C/C++ [image: icon7].


	Code performance analysis using the debugger




Based on the previous project demo, open the Compile Options dialog box in step 3 and set the Optimization Level to -O0 in the Optimization/Debugging column. Then click [image: icon8] to recompile the project, and click [image: icon9] to enter the debugging interface. Click Debugger in the main menu of the debugging interface, select Disassembly from the menu drop-down menu, open the disassembly code window, and you can see that the program is paused at the entrance of the main() function. In the same way, select Profiling in the Debugger drop-down menu, open the performance analysis window and click [image: icon10].

[image: figure8]

The Profiling window displays the corresponding of the number of executed instructions of the program with each function under the current debug window. From left to right, the total number of executions of function instructions in the total number of executions of the entire program instruction, the total number of executions of the accumulated instructions, the total number of executions of the functions, the number of times the function is called, the number of including functions, the address of the function, and the name of the function. Through the relationship between the instruction information and the function in the Profiling window, it is very convenient to analyze the program efficiency and find the shortcoming of the program performance.

Use this project as an example to continue to introduce the use of the Profiling window. The program is paused at the entrance of the main() function and the Profiling window opens. The main() function is the main object of performance analysis optimization. The content displayed in the Profiling window is some function information initialized by the processor before the main() function is executed. Click [image: icon11] in the Profiling window to clear the current information. If you click [image: icon12], nothing is displayed, and it indicates that the cleaning is successful. Set a breakpoint at the last statement of the main() function (either C statement or assembly statement), and click [image: icon13] in the toolbar above the debug interface to let the program run until it hits the breakpoint. Click [image: icon14] in the Profiling window, and only the information related to the main() function is displayed. Therefore, flexible setting of breakpoints, combined with the clear function, can perform performance analysis on the concerned blocks.

[image: figure9]

It can be seen that the multiplication library function _mw_mpy_32x32y32 in
the main() function is called 20 times, and a total of 2064 instructions are
executed, while the main() function itself executes only 326 instructions, and
the memcpy function executes 86 instructions. It can be seen that the
implementation of the multiplication function of the program consumes a large
number of instructions, and the large number of instructions means that the
processor spends a large number of computation cycles to perform
multiplication operations. Therefore, multiplication is the shortcoming of
current program performance. If you want to improve the performance of the
program, you should consider how you can use fewer instructions and
implement multiplication more efficiently.



Exercises

Enable MPY extension instrctions by setting Multiply Option -Xmpy_option = wlh1 in step 3, it implements multiplication more efficiently with fewer instructions.
Redo steps 4 - 7 to analyze with the debugger’s Profiling function, observe the total number of instructions consumed by the main function, and compare it with the above Profiling result.




GNU Toolchain for ARC Processors


Purpose


	Learn the GNU Toolchain for ARC Processors


	Familiar with the GNU Toolchain for ARC Processors


	Familiar with the functions and usage of the GNU Toolchain for ARC Processors debugger






Requirements

The following hardware and tools are required:


	PC host


	GNU Toolchain for ARC Processors


	nSIM simulator or ARC board (EM Starter Kit / IoT Development Kit)


	embarc_osp/arc_labs/labs/lab_core_test






Content


	Create a C project using GNU Toolchain for ARC Processors


	Import the code CoreTest.c from embarc_osp/arc_labs/labs/lab_core_test


	Configure compilation options to compile, and generate executable files


	Start the GNU Toolchain for ARC Processors debugger to enter the debug mode




From two different perspectives of C language and assembly language, use the methods of setting breakpoint, single-step execution, full-speed executions, and so on combined with observing PC address, register status, global variable status, and profiling performance to analyze and debug the target program.



Principles

Use the GNU Toolchain for ARC Processors integrated development environment to create projects and load routine code. In the engineering unit, configure the compile option compilation routine code to debug and analyze the compiled executable file.



Steps


	Create a project




Open the GNU Toolchain for ARC Processors, create an empty project called core_test, and select ARC EM series processor.

[image: figure10]


	Import the code file CoreTest.c to the project demo




In the Project Explorer, right-click [image: icon15], and select Import..

In the Implort wizard, select File system from the General tab, then click Next. As shown in the following figure, in the From directory fileld, type or browse to select the directory contain the file CoreTest.c. Recent directories that have been imported from are shown on the From directory field’s combo box. In the left pane, check a folder that imports the contents into the Workbench, and in the right pane check the file CoreTest.c.

[image: figure11]

Click Finish when done, the file CoreTest.c is now shown in the one of the navigation views in the project core_test.


	Set compilation options




From the Project Explorer view, right-click the project core_test and choose Properties. Click C/C++ Build > Settings > Tool Settings.
The Tool Settings dialog opens.

[image: figure12]

Select Debugging to set the compiler optimization
and debugging level. For example, set the optimization level to off
optimization, and the debugging level is to load all debugging information.

Select Processor in the current interface to set the compile options
corresponding to the target processor hardware attributes, such as the version
of the processor, whether to support extended instructions such as shift,
multiplication, floating-point operations, and so on whether to include Timer0/1.

In step 1, you built the project using the engineering template of
EMSK, the corresponding necessary options have been set by default. If
there is no special requirement, check the setting compile options in the All
options column and click OK when done.


	Build project




In the Project Explorer view, select project core_test.

Click Project > Build Project or click [image: icon16].
In the middle of the GNU Toolchain for ARC Processors main interface, you can see in the Console view the output and results of the build command. Click the tab to bring the view forward if it is not currently visible. If for some reason it is not present, you can open it by selecting Window > Show View > Console. When the message Finished building target: Core_test.elf is displayed, the compilation is successful, and the compiled executable file Core_test.elf can be seen in the Project Explorer.

[image: figure13]


	Set debugger options




Click the Run > Debug Configurations… menu option to open the Debug Configurations dialog.
Double-click C/C++ Application or right-click New to create a new launch configuration.

[image: figure14]

If a project is selected in the Project Explorer view all data is automatically entered, take a moment to verify its accuracy or change as needed. As you use nSIM simulator to simulate EMSK development board, you need to modify the settings of Debugger, Common, and Terminal (this is because nSIM cannot be called directly in GNU IDE. Still needs GDB Server for indirect calls). The specific settings are as follows:


	Set Debugger->Gdbserver Settings




[image: figure15]

Select nSIM as the ARC GDB Server, and the default port number is 49105. Note that Use TCF is enabled. Otherwise, the nSIM cannot work normally. The TCF start file is under nSIM/nSIM/etc/tcf/templates (the default installation path). If you have downloaded the MetaWare IDE, the default nSIM path is C:/ARC/nSIM/nSIM/etc/tcf/templates, and you can select a TCF file from this folder (depending on the version of the board you are simulating and the kernel model), as shown earlier.


	Pay attention to Debug in Common




[image: figure16]


	Terminal settings




If you are using the EM Starter Kit, the terminal automatically selects the correct port number, and if you are using the emulator without a port, uncheck it as shown in the following figure.

[image: figure17]

When you are done, click Debug to enter the debugging interface.


	Debug executable file core_test.elf




You may be prompted to switch to the Debug perspective. Click Yes.

The Debug perspective appears with the source code window, assembly code window, register window, global variable window, breakpoint window, function window, and so on.

[image: figure18]

In the C code window, right-click the code line number on the left side of the window, select Toggle Breakpoint or double-click the line number to set a breakpoint on. In the assembly code window, double-click a line of code to set a breakpoint on. A blue circle is seen indicating the breakpoint is set.

After the breakpoint is set, click Run > Resume or you can use the Resume button [image: icon3] on the toolbar of the Debug view to run the program. The program runs directly to the nearest breakpoint. You can observe the current program execution and the relevant status information of the processor through the various windows as described in previous step. If you want to know more about the details of program execution and the instruction behavior of the processor, you can use the following three execution commands [image: icon4] to perform single-step debugging. The icon [image: icon5] can choose to step through a C language statement or an assembly instruction to match the status information of each window. It can be very convenient for program debugging. If you want to end the current debugging process, click [image: icon6]. If you want to return to the main GNU Toolchain for ARC Processors page, click C/C++ [image: icon7].


	Code performance analysis using the debugger




Same as the code performance analysis method of MetaWare Development Toolkit.

For the use of these two IDEs, you can refer to the Help documentation in the respective IDE, or you can view the on-line documentation provided by Synopsys.
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How to use embARC OSP


Purpose


	To know the concept of embARC OSP


	To know how to run examples in embARC OSP


	To know how to debug the examples in embARC OSP


	To know how to create application in embARC OSP






Requirements

The following hardware and tools are required:


	PC host


	GNU Toolchain for ARC Processors / MetaWare Development Toolkit


	ARC board (EM Starter Kit / IoT Development Kit)


	embARC OSP packages




For the detailed tool requirements of embARC OSP, see Software Requirement [http://embarc.org/embarc_osp/doc/build/html/getting_started/software_requirement.html].



Content


	A brief introduction of embARC OSP


	Get embARC OSP and run and debug the provided examples


	Create an embARC OSP application






Principles


	IoT OS/Platform




As more and more devices are connected and become more complex, the tools
running in them are becoming more and more complex.

An IoT OS is an operating system that is designed to perform within the
constraints that are particular to Internet of Things devices, including
restrictions on memory, size, power, and processing capacity. IoT operating
systems are a type of embedded OS but by definition are designed to enable
data transfer over the Internet and more other features.


	embARC OSP




The embARC OSP is an open software platform to
facilitate the development of embedded systems based on DesignWare® ARC® processors.

It is designed to provide a unified platform for DesignWare® ARC® processors users by defining
consistent and simple software interfaces to the processor and peripherals,
together with ports of several well known FOSS embedded software stacks to
DesignWare® ARC® processors.

For more details, see embARC OSP online documentation [http://embarc.org/embarc_osp/doc/build/html/introduction/introduction.html]


	Other platforms




Besides embARC OSP, there are also other IoT platforms:


	Zephyr [https://www.zephyrproject.org/]


	Amazon FreeRTOS [https://aws.amazon.com/freertos/]






Steps


Get embARC OSP


	git




The embARC OSP source code is hosted in a GitHub repository [https://github.com/foss-for-synopsys-dwc-arc-processors/embarc_osp].
The repository consists of scripts and other things to you need to setup your development environment, and use Git to get this repo. If you do not have Git installed, see the beginning of the OS-specific instructions for help.

Using Git to clone the repository anonymously.

# On Windows
cd %userprofile%
# On Linux
cd ~

git clone https://github.com/foss-for-synopsys-dwc-arc-processors/embarc_osp.git embarc_osp





You have checked out a copy of the source code to your local machine.


	http download




You may also try to get the latest release of embARC OSP as a zip from the repository,
see release page [https://github.com/foss-for-synopsys-dwc-arc-processors/embarc_osp/releases].



Run the examples

The command-line interface is the default interface to use embARC OSP. After getting the embARC OSP
package, you need to open a cmd console in Windows or a terminal in Linux and change directory to the root of embARC OSP.

Use the blinky as an example.


	Go to the blinky example folder




cd example\baremetal\blinky






	Connect your board to PC host, and open the UART terminal with putty/tera term/minicom


	Build and run it with command, here ARC GNU toolchain is selected




# For EMSK 2.3
make TOOLCHAIN=gnu BOARD=emsk BD_VER=23 CUR_CORE=arcem11d run
# For EMSK 2.2
make TOOLCHAIN=gnu BOARD=emsk BD_VER=22 CUR_CORE=arcem7d run
# For IoTDK
make TOOLCHAIN=gnu BOARD=iotdk run






Note

For EM Starter Kit, make sure the board version (BD_VER) and core configuration (CUR_CORE) match your hardware.
You could press configure button (located above the letter “C” of the ARC logo on the EM Starter Kit) when bit 3 and bit 4 of SW1 switch is off to run a self-test. By doing so, board information is sent by UART and displayed on your UART terminal.
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How to use ARC board


Purpose


	To get familiar with the usage of ARC board and on-board peripherals


	To know how to program and debug the ARC board and on-board peripherals






Requirements

The following hardware and tools are required:


	PC host


	GNU Toolchain for ARC Processors / MetaWare Development Toolkit


	ARC board (EM Starter Kit / IoT Development Kit)


	embarc_osp/arc_labs/labs/lab5_emsk / embarc_osp/arc_labs/labs/lab5_iotdk






Content


	A brief introduction of ARC board and on-board peripherals


	Based on embARC OSP, program the GPIO to control some on-board peripherals





Note

About the detailed usage of embARC OSP, see How to use embARC OSP [http://embarc.org/arc_labs/doc/build/html/labs/level1/lab2.html]
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ARC features: AUX registers and timers


Purpose


	To know the auxiliary registers and processor timers of DesignWare® ARC® processors


	To learn how to program auxiliary registers to control the processor timers






Requirements

The following hardware and tools are required:


	PC host


	GNU Toolchain for ARC Processors / MetaWare Development Toolkit


	ARC board (EM Starter Kit / IoT Development Kit)


	embarc_osp/arc_labs/labs/lab_timer






Content


	Through reading the corresponding Build Configuration Register (BCR) auxiliary registers of processor timers to get the configuration information


	Through programming the auxiliary registers to initialize, start and stop the timer (here TIMER0 is used)


	By reading the count value of processor timers, get the execution time of a code block






Principles


Auxiliary Registers

The auxiliary register set contains status and control registers, which by default are 32 bits wide to implement the processor control, for example, interrupt and exception management and processor timers. These
auxiliary registers occupy a separate 32-bit address space from the normal memory-access (that is load and
store) instructions. Auxiliary registers accessed using distinct Load Register (LR), Store Register (SR), and
Auxiliary EXchange (AEX) instructions.

The auxiliary register address region 0x60 up to 0x7F and region 0xC0 up to 0xFF is reserved for the Build
Configuration Registers (BCRs) that can be used by embedded software or host debug software to detect the
configuration of the ARCv2-based hardware. The Build Configuration Registers contain the version of each
ARCv2-based extension and also the build-specific configuration information.

In embARC OSP, arc_builtin.h provides API (arc_aux_read and arc_aux_read) to access the auxiliary registers.



Processor Timers

The processor timers are two independent 32-bit timers and a 64-bit real-time
counter (RTC). Timer0 and Timer1 are identical in operation. The only
difference is that these timers are connected to different interrupts. The
timers cannot be included in a configuration without interrupts. Each timer is
optional and when present, it is connected to a fixed interrupt; interrupt 16
for timer 0 and interrupt 17 for timer 1.

The processor timers are connected to a system clock signal that operates even
when the ARCv2-based processor is in the sleep state. The timers can be used
to generate interrupt signals that wake the processor from the SLEEP state. The
processor timers automatically reset and restart their operation after
reaching the limit value. The processor timers can be programmed to count only
the clock cycles when the processor is not halted. The processor timers can
also be programmed to generate an interrupt or to generate a system Reset upon
reaching the limit value. The 64-bit RTC does not generate any interrupts.
This timer is used to count the clock cycles atomically.

Through the BCR register 0x75, you can get the configuration information of processor timers

In embARC OSP, arc/arc_timer.h provides API to operate the processor timers.



Program flow chart

The code’s flow is shown below:

[image: program flow chart]
The code can be divided into 3 parts:


	Part1 : read the BCR of internal timers to check the features


	Part2 : promgram Timer0 by auxiliary registers with the embARC OSP provided API


	Part3 : read the counts to Timer 0 to measure a code block’s execution time







Steps


	Build and Run




$ cd <embarc_root>/arc_labs/labs/lab_timer
# for emsk
$ make BOARD=emsk BD_VER=22 CUR_CORE=arcem7d TOOLCHAIN=gnu run
# for iotdk
$ make BOARD=iotdk TOOLCHAIN=gnu run






	Output




-----------------------------------------------------------
      ____                                _ ____
     |  _ \ _____      _____ _ __ ___  __| | __ ) _   _
     | |_) / _ \ \ /\ / / _ \ '__/ _ \/ _` |  _ \| | | |
     |  __/ (_) \ V  V /  __/ | |  __/ (_| | |_) | |_| |
     |_|   \___/ \_/\_/ \___|_|  \___|\__,_|____/ \__, |
                                                  |___/
                          _       _    ____   ____
            ___ _ __ ___ | |__   / \  |  _ \ / ___|
           / _ \ '_ ` _ \| '_ \ / _ \ | |_) | |
          |  __/ | | | | | |_) / ___ \|  _ <| |___
           \___|_| |_| |_|_.__/_/   \_\_| \_\\____|
     ------------------------------------------------------------

     embARC Build Time: Aug 22 2018, 15:32:54
     Compiler Version: MetaWare, 4.2.1 Compatible Clang 4.0.1 (branches/release_40)
     Does this timer0 exist?  YES
     timer0's operating mode:0x00000003
     timer0's limit value :0x00023280
     timer0's current cnt_number:0x0000c236

     Does this timer1 exist?  YES
     timer1's operating mode:0x00000000
     timer1's limit value :0x00000000
     timer1's current cnt_number:0x00000000

     Does this RTC_timer exist?   NO

     The start_cnt number is:2
     /******** TEST MODE START ********/

     This is TEST CODE.

     This is TEST CODE.

     This is TEST CODE.

     /******** TEST MODE END ********/
     The end_cnt number is:16785931
     The board cpu clock is:144000000

     Total time of TEST CODE BLOCK operation:116







Exercises


	Try to program TIMER1


	Try to create a clock with a tick of 1 second
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ARC features: Interrupts


Purpose


	To introduce the interrupt handling of DesignWare® ARC® processors


	To know how to use the interrupt and timer APIs already defined in embARC OSP






Requirements

The following hardware and tools are required:


	PC host


	GNU Toolchain for ARC Processors / MetaWare Development Toolkit


	ARC board (EM Starter Kit / IoT Development Kit)


	embarc_osp/arc_labs/labs/lab_interrupt






Content


	Through embarc_osp/arc_labs/labs/lab_interrupt/part1 to learn the basics of interrupt handling of DesignWare® ARC® processors and the interrupt API provided by embARC OSP


	Through embarc_osp/arc_labs/labs/lab_interrupt/part2 to learn the interrupt priority and interrupt nesting of DesignWare® ARC® processors and corresponding API of embARC OSP






Principles


	Interrupt




An interrupt is a mechanism in processor to respond to special interrupt signals emitted by hardware or software. Interrupts can be used by processor to perform a specific function after some specific event happens and then return to normal operation. For this purpose there are many different types of interrupts possible to be issued by hardware and software and each interrupt can have it’s own functions called Interrupt Service Routine (ISR). ISR is a function (sequence of commands) to deal with the immediate event generated by a given interrupt.


	Interrupt unit of DesignWare® ARC® processors




The interrupt unit of DesignWare® ARC® processors has 16 allocated exceptions associated with vectors 0
to 15 and 240 interrupts associated with vectors 16 to 255. The ARCv2 interrupt unit
is highly programmable and supports the following interrupt types:


	Timer — triggered by one of the optional extension timers and watchdog timer


	Multi-core interrupts —triggered by one of the cores in a multi-core system


	External — available as input pins to the core


	Software-only — triggered by software only




The interrupt unit of DesignWare® ARC® processors has the following interrupt specifications:


	
	Support for up to 240 interrupts

	
	User configurable from 0 to 240


	Level sensitive or pulse sensitive










	
	Support for up to 16 interrupt priority levels

	
	Programmable from 0 (highest priority) to 15 (lowest priority)










	The priority of each interrupt can be programmed individually by software


	
	Interrupt handlers can be preempted by higher-priority interrupts

	
	Optionally, highest priority level 0 interrupts can be configured as “Fast Interrupts”


	Optional second core register bank for use with Fast Interrupts option to minimize interrupt service latency by minimizing the time needed for context saving










	Automatic save and restore of selected registers on interrupt entry and exit for fast context switch


	User context saved to user or kernel stack, under program control


	Software can set a priority level threshold in STATUS32.E that must be met for an interrupt request to interrupt or wake the processor


	
	Minimal interrupt / wake-up logic clocked in sleep state

	
	Interrupt prioritization logic is purely combinational










	Any Interrupt can be triggered by software




The interrupt unit can be programmed by auxiliary registers. For more details, See DesignWare® ARC® processors ISA.


	Interrupt API in embARC OSP




In embARC OSP, a basic exception and interrupt processing framework is implemented in embARC OSP. Through this framework, you can handle specific exceptions or interrupts by installing the desired handlers. This can help you analyze the underlying details of saving and operating registers. See here [http://embarc.org/embarc_osp/doc/build/html/arc/arc.html#arc-hal-exc-int] for detais.

The interrupt and exception related API are defined in arc_exception.h.



Steps


Part I: implement a customized timer0 interrupt handling


	Build and Run




$ cd <embarc_root>/arc_labs/labs/lab4_interrupt/part1
# for emsk
$ make BOARD=emsk BD_VER=22 CUR_CORE=arcem7d TOOLCHAIN=gnu run
# for iotdk
$ make BOARD=iotdk TOOLCHAIN=gnu run






	Output




embARC Build Time: Mar 16 2018, 09:58:46
Compiler Version: Metaware, 4.2.1 Compatible Clang 4.0.1

This is an example about timer interrupt
/********TEST MODE START********/
0s

1s

2s

3s

4s

5s

...






	Code analysis




The code can be divided into three parts: interrupt service function, main function, and delay function.


	Interrupt service function:




static void timer0_isr(void *ptr)
{
  arc_timer_int_clear(TIMER_0);
  t0++;
}





This code is a standard example of an interrupt service routine: enters the service function, clears the interrupt flag bit, and then performs the processing that needs to be done in the interrupt service function. Other interrupt service functions can also be written using this template.

In this function, the count variable t0 is incremented by one.


	Main function




    int main(void)
    {
      int_disable(INTNO_TIMER0);
      arc_timer_stop(TIMER_0);

      int_handler_install(INTNO_TIMER0, timer0_isr);
      int_pri_set(INTNO_TIMER0, INT_PRI_MIN);

      EMBARC_PRINTF("\r\nThis is a example about timer interrupt.\r\n");
      EMBARC_PRINTF("\r\n/******** TEST MODE START ********/\r\n\r\n");

      int_enable(INTNO_TIMER0);
      arc_timer_start(TIMER_0, TIMER_CTRL_IE | TIMER_CTRL_NH, COUNT);

      while(1)
      {
            timer0_delay_ms(1000);
            EMBARC_PRINTF("\r\n %ds.\r\n",second);
            second ++;
      }
      return E_SYS;
}





The EMBARC_PRINTF function is only used to send information to the computer, which can be ignored during analysis.

This code is divided into two parts: initialization and looping.

In the initialization section, the timer and timer interrupts are configured.

This code uses the embARC OSP API to program Timer0. These two methods are the same. The API just encapsulates the read and write operations of the auxiliary registers for convenience.

First, in order to configure Timer0 and it’s interrupts, turn them off first. This work is done by the functions int_disable and arc_timer_stop.

Then configure the interrupt service function and priority for our interrupts. This work is done by the functions int_handler_install and int_pri_set.

Finally, after the interrupt configuration is complete, enable the Timer0 and interrupts that are previously turned off. This work is done by the functions int_enable and arc_timer_start.
The implementation of the arc_timer_start function is the same as the reading and writing of the auxiliary registers in lab_timer. You can view them in the file arc_timer.c. One point to note in this step is the configuration of timer_limit (the last parameter of arc_timer_start). Configure the interrupt time to 1ms, do a simple calculation (the formula is the expression after COUNT).

In this example, the loop body only serves as an effect display. Delay function in the loop body to print the time per second is called.


Note

Since nSIM is only simulated by computer, there may be time inaccuracy when using this function. You can use the EMSK to program the program in the development board. In this case, the time is much higher than that in nSIM.
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A simple bootloader


Purpose


	Understand the memory map of ARC boards


	Understand the principles of bootloader and self-booting


	Understand the usage of shell commands in cmd


	Create a self-booting application






Requirements

The following hardware and tools are required:


	PC host


	GNU Toolchain for ARC Processors / MetaWare Development Toolkit


	ARC board (EM Starter Kit / IoT Development Kit)


	SD card


	example/baremetal/bootloader






Simple Bootloader

This simple bootloader is designed to work as a secondary/simple bootloader
for embARC OSP, it loads boot.hex or boot.bin on SD Card and run that program.
The example can be used as ntshell application.

The following features are provided in this simple bootloader:


	Boot application from SD card


	File operations on SD card


	UART Y-modem protocol to update application


	Operations on ARC processors






Content


	Build and run the example/baremetal/bootloader


	Download the generated bootloader.bin into flash


	Build a self-boot application and boot it from SD card


	Use the ntshell commands






Principles


Memory Map of ARC board


EM Starter Kit

The available memory regions of EM Starter Kit are shown below:


Memory Map of EM Starter Kit

	Name

	Start address

	Size





	on-chip ICCM

	0x00000000

	256/128 KB



	on-chip DCCM

	0x80000000

	128 KB



	on-board DDR RAM

	0x10000000

	128 MB






In this lab, the last 1 MB of DDR (starting from 0x17f00000) is reserved for the
simple bootloader, other memory regions are available for application.



IoT Development Kit

The available memory regions of IoT Development Kit are shown in the following table:


Memory Map of IoT Development Kit

	Name

	Start address

	Size





	on-chip eflash

	0x00000000

	256 KB



	external boot SPI flash

	0x10000000

	2 MB



	on-chip ICCM

	0x20000000

	256 KB



	on-chip SRAM

	0x30000000

	128 KB



	on-chip DCCM

	0x80000000

	128 KB



	on-chip XCCM

	0xC0000000

	32 KB



	on-chip YCCM

	0xE0000000

	32 KB






In this lab, on-chip eflash and on-chip SRAM are reserved for the simple
bootloader, CCMs are reserved for application.




Boot of ARC board


EM Starter Kit

The EM Starter Kit uses a Xilinx SPARTAN-6 FPGA part which can be configured to run
different members of the ARCv2 EM Processor family. The EMSK includes a SPI
flash pre-programmed with four FPGA configurations of ARC EM cores.

When a “power on” or reset/configure is issued, the FPGA auto-loads one of
the pre-installed FPGA configurations from SPI flash. After the FPGA
configuration is loaded from the SPI flash, a simple primary bootloader is
loaded in ICCM. Through the primary bootloader, an application can be loaded
from SPI Flash into ICCM or external DDR memory.

Considering that the SPI Flash is used to store FPGA images, the secondary
bootloader is designed based on the primary bootloader to load an application
from an SD card since it can be read and written easily. The startup sequence
is listed below:


	Power on or reset event.


	Load FPGA configuration from the SPI flash.


	Run primary bootloader, which loads the secondary bootloader from the SPI Flash into main memory (DDR).


	Run secondary bootloader from main memory to load application from the SD card into ICCM/DDR memory.


	Run the application from ICCM/DDR memory.




[image: Boot sequence of EMSK]


IoT Development Kit

IoT Development Kit can boot from on-chip eflash and extern boot SPI flash, which is decided by
the FWU switch of IOTDK. When this switch is set to “off”, the processor
starts executing the program stored in on-chip eflash; When this switch is set
to “on”, the processor starts executing the program stored in external boot
SPI eflash. The simple bootloader can be written to both flash to load an application
from the TF card. The startup sequence for IoT Development Kit is listed below:


	Power on or reset event


	Boot from on-chip eflash or extern boot SPI flash decided by the FWU switch


	Run simple bootloader to load application from the TF card into ICCM


	Run the application from ICCM memory







How to flash the ARC board


Note

In this lab, we do not use MCUBoot, so we need to disable MCUBoot, we should set USE_MCUBOOT = 0 in makefile.
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Advanced labs



	Memory map and linker

	A WiFi temperature monitor

	BLE Communication

	How to use FreeRTOS

	ARC DSP: Compiler Optimizations

	ARC DSP: Using FXAPI

	ARC DSP: Using DSP Library
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Memory map and linker


Purpose


	To get familiar with memory layout in compilation process


	To learn how to use linker






Requirements

The following hardware and tools are required:


	PC host


	ARC GNU toolchain/MetaWare Development Toolkit


	nSIM simulator


	embarc_osp/arc_labs/labs/lab8_linker






Content


	Customizing your program with compiler pragmas.


	Using “pragma code” to specify a new name of section in which the code of function reside.


	Mapping this code section into specified memory location with linker.


	Checking the location of this code section after build process.






Principles

By default, compiler-generated code is placed in the .text section. The default code section name can be overridden by using the code pragma. After compilation process, the linker automatically maps all input sections from object files to output sections in executable files. If you want to customize the mapping, you can change the default linker mapping by invoking a linker command file.



Steps


Create a project and overriding code section name

Open MetaWare IDE, create an empty C project called lab_linker and select ARC EM series processor. Import the main.c and link.cmd files from the embarc_osp/arc_labs/labs/lab8_linker directory into the project.

Open main.c file in MetaWare IDE, use “pragma code” to change the section in which function modify reside from .text to a new name “modify_seg”.

#pragma Code ("modify_seg")
void modify(int list[], int size) {
    int out, in, temp;

    for(out=0; out<size; out++)
        for(in=out+1; in<size; in++)
            if(list[out] > list[in]) {
                temp = list[in];
                list[in] = list[out];
                list[out] = temp;
            }
}
#pragma Code ()





Pragma code has two forms that must be used in pairs to bracket the affected function definitions:

#pragma code(Section_name)
/* ----- Affected function definitions go here ---- */
#pragma code() /* No parameters here */





Section_name is a constant string expression that denotes the name of the section.


Note

About detailed usage of the compiler pragmas, see MetaWare C/C++ Programmer’s Guide for the ccac Compiler.
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A WiFi temperature monitor


Purpose


	To learn how to build a wireless sensor terminal based on the embARC OSP package


	To know how to use ESP8266 module and AT commands


	To learn more about the usage of FreeRTOS operating system






Requirements

The following hardware and tools are required:


	PC host


	GNU Toolchain for ARC Processors / MetaWare Development Toolkit


	ARC board (IoT Development Kit)


	embARC OSP package


	embarc_osp/arc_labs/labs/lab_esp8266_wifi






Content

Through this lab, you get a preliminary understanding of ESP8266 WiFi module and the AT command.

The lab is based on the embARC OSP package and the supports of the popular WiFi module, ESP8266.
During the lab, you first use the AT command to set the ESP8266 to the server mode.
Then you can use your laptop or mobile phone to access ESP8266 by IP address.
You get a static webpage transmitted via TCP protocol.



Principles

ESP8266

The ESP8266 is an ultra-low-power WiFi chip with industry-leading package size and ultra-low power technology.
It is designed for mobile devices and IoT applications, facilitating the connection between user devices to IoT environments.

The ESP8266 is available with various encapsulations. On-board PCB antenna, IPEX interface, and stamp hole interface are supported.

ESP8266 can be widely used in smart grid, intelligent transportation, smart furniture, handhold devices, industrial control, and other IoT fields.

Ai-Thinker company has developed several WiFi modules based on ESP8266, including ESP01 and ESP01S which are used in this lab.


Note

See embARC doc [http://embarc.org/embarc_osp/doc/build/html/getting_started/peripheral_preparation.html#other-pmod-or-compatible-modules] to learn how to connect it with your board.
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BLE Communication


Purpose


	To get familiar with the wireless communication in IoT


	To get familiar with the usage of RN4020 BLE module on IoT Development Kit


	To learn the usage of APIs of RN4020 driver in embARC OSP






Requirements

The following hardware and tools are required:


	PC host


	A smartphone which supports BLE


	ARC GNU toolchain/MetaWare Development Toolkit


	ARC board (IoT Development Kit)


	embARC OSP package


	embarc_osp/arc_labs/labs/lab6_ble_rn4020






Content

The communication between smartphone and IoT Development Kit board with RN4020 BLE module.


	Setup RN4020 BLE module by using API of RN4020 driver.


	Connect smartphone and RN4020 by BLE, and check the data send by IoT Development Kit in smartphone.


	Send data from smartphone to IoT Development Kit board, and print this data value in terminal.






Principles

RN4020 BLE module is controlled by the user through input/output lines (that is physical device pins) and an UART interface.
The UART Interface supports ASCII commands to control/configure the RN4020 modules for any specific requirement based on the application.


Setup

Before connecting an RN4020 module to a smartphone device, you might need to set up the RN4020 module as follows.


	Configure UART which is connected to RN4020 with these parameters: Baud rate - 115200, Data bits - 8, Parity - None, Stop bits - 1


	Set the WAKE_SW pin high to enter command mode


	Run the command SF, 1 to reset to the factory default configuration


	Run the command SN, IoT DK to set the device name to be “IoT DK”


	Run the command SS, C0000001 to enable support of the Device Information, Battery Service, and User-Defined Private Service


	Run the command SR, 00002000 to set the RN4020 module as a server


	Run the command PZ to clear all settings of the private service and the private characteristics


	Run the command PS, 11223344556677889900AABBCCDDEEFF to set the UUID of user-defined private service to be 0x11223344556677889900AABBCCDDEEFF


	Run the command PC, 010203040506070809000A0B0C0D0E0F, 18, 06 to add private characteristic 0x010203040506070809000A0B0C0D0E0F to current private service. The property of this characteristic is 0x18 (writable and could notify) and has a maximum data size of 6 bytes.


	Run the command R, 1 to reboot the RN4020 module and to make the new settings effective


	Run the command LS to display the services




The source code using the API of RN4020 driver in embARC OSP as follows.

rn4020_setup(rn4020_ble);
rn4020_reset_to_factory(rn4020_ble);

/* Set device Name */
rn4020_set_dev_name(rn4020_ble, "IoT DK");

/* Set device services */
rn4020_set_services(rn4020_ble, RN4020_SERVICE_DEVICE_INFORMATION |
                                RN4020_SERVICE_BATTERY |
                                RN4020_SERVICE_USER_DEFINED);

rn4020_set_features(rn4020_ble, RN4020_FEATURE_SERVER_ONLY);
rn4020_clear_private(rn4020_ble);

/* Set private service UUID and private characteristic */
rn4020_set_prv_uuid(rn4020_ble, RN4020_PRV_SERV_HIGH_UUID, RN4020_PRV_SERV_LOW_UUID);
rn4020_set_prv_char(rn4020_ble, RN4020_PRV_CHAR_HIGH_UUID, RN4020_PRV_CHAR_LOW_UUID, 0x18, 0x06, RN4020_PRIVATE_CHAR_SEC_NONE);

/* Reboot RN4020 to make changes effective */
rn4020_reset(rn4020_ble);

rn4020_refresh_handle_uuid_table(rn4020_ble);







Advertise

Run the command A to start advertisement.
The source code using the API of RN4020 driver in embARC OSP as follows:

rn4020_advertise(rn4020_ble);







Send data

Run the command SUW, 2A19, value to set the level of Battery.
The source code using the API of RN4020 driver in embARC OSP as follows:

while (1) {

        rn4020_battery_set_level(rn4020_ble, battery--);

        board_delay_ms(1000, 0);
        if (battery < 30) {
                battery = 100;
        }
}






Note

About detailed usage of RN4020 BLE module, see RN4020 Bluetooth Low Energy Module User’s Guide.
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How to use FreeRTOS


Purpose


	To learn how to implement tasks in FreeRTOS operating system


	To learn how to register tasks in FreeRTOS


	To get familiar with inter-task communication of FreeRTOS






Requirements

The following hardware and tools are required:


	PC host


	GNU Toolchain for ARC Processors / MetaWare Development Toolkit


	ARC board (EM Starter Kit / IoT Development Kit)


	embARC OSP package


	embarc_osp/arc_labs/labs/lab9_freertos






Content

This lab utilizes FreeRTOS v9.0.0, and creates 3 tasks based on embARC OSP. You should apply inter-task communicating methods such as semaphore and message queue in order to get running LEDs result. You should know the basic functions of FreeRTOS.



Principles


Background

Operating system is software that controls basic hardware and software resources and provides access to them as a service for applications. In this sense applications that are used are said to be run on top of or inside the operating system.

There are different kind of operating systems and many definitions of operating systems depending on the available features. One of the main features of every operating system is how it organizes several tasks (programs) to work together. Some operating systems execute only one task at the time (these are called single-tasking) other allow multiple programs to work together (multi-tasking). Most common desktop operating systems are multi-tasking (Linux, Windows, and so on).

As processors on which programs are executed are sequential devices, technically only single program can be run at a time on a processor. However, multi-tasking does periodical switching between several tasks creating an illusion that these tasks work in parallel. The part of operating system that does this work is called scheduler. Scheduler is a routine that decides the order of execution of several tasks running on operating system.

Depending on scheduler multi-tasking algorithm operating systems are classified on real-time and non-real-time. In desktop operating systems (Linux, Windows) the usual approach of scheduler is to try to distribute processor time evenly between running application, so that each uses fair amount of resources. However, this approach has significant drawback which is unpredictable times when specific task are running. On the other hand, some applications (especially embedded) are time constrained and thus require deterministic execution of tasks. For example, if embedded system is controlling industrial machinery and software application is controlling some operation in the machine, which should be done at specific times disregarding of what other operations are pending. For this purpose, schedulers in some operating systems are made in a way to start tasks and predefine times. Such operating systems are called real-time operating systems (RTOS), because each task (application) running in RTOS can specify specific time (in milliseconds or other real time unit) at which it should be started. To organize this for several tasks, scheduler uses priorities set for tasks, so that if two applications requested to be called at the same time, the one with higher priority gets the resources.

As resources becoming abundant for modern micro processors, the cost to run RTOS becomes increasingly insignificant. RTOS also provides event-driven mode for better utilization of CPU with efficiency.

FreeRTOS is an implementation of RTOS specially designed to be compact, easy to use and freely available (under GPL license with several exceptions). FreeRTOS source code is available for download at http://freertos.org and for different processor it could be ported (architecture specific code needs to be changed) so that it can operate on the specific processor. embARC OSP includes FreeRTOS port for DesignWare® ARC® processors that can be used to run applications using RTOS. FreeRTOS contains all the basic features of RTOS: tasks, scheduler, notifications, semaphores, mutexes, and so on.



Design

This lab implements a running LED light with 3 tasks on FreeRTOS. Despite using 3 tasks overkill for a running LED, but it is beneficial for the understanding of FreeRTOS itself and inter-task communication as well.

The following is the flow chart of the program:

[image: program flow chart]


Realization

The following is the example code of system , including various initialization and task time delay.

#include "embARC.h"
#include "embARC_debug.h"
#include <stdlib.h>

static void task1(void *par);
static void task2(void *par);
static void task3(void *par);

#define TSK_PRIOR_1             (configMAX_PRIORITIES-1)
#define TSK_PRIOR_2             (configMAX_PRIORITIES-2)
#define TSK_PRIOR_3             (configMAX_PRIORITIES-3)

// Semaphores
static SemaphoreHandle_t sem1_id;

// Queues
static QueueHandle_t dtq1_id;

// Task IDs
static TaskHandle_t task1_handle = NULL;
static TaskHandle_t task2_handle = NULL;
static TaskHandle_t task3_handle = NULL;

int main(void)
{
        vTaskSuspendAll();

        // Create Tasks
        if (xTaskCreate(task1, "task1", 128, (void *)1, TSK_PRIOR_1, &task1_handle)     != pdPASS){
                /*!< FreeRTOS xTaskCreate() API function */
                EMBARC_PRINTF("Create task1 Failed\r\n");
                return -1;
        } else {
                EMBARC_PRINTF("Create task1 Successfully\r\n");
        }

        if (xTaskCreate(task2, "task2", 128, (void *)2, TSK_PRIOR_2, &task2_handle)     != pdPASS){
                /*!< FreeRTOS xTaskCreate() API function */
                EMBARC_PRINTF("Create task2 Failed\r\n");
                return -1;
        } else {
                EMBARC_PRINTF("Create task2 Successfully\r\n");
        }

        if (xTaskCreate(task3, "task3", 128, (void *)3, TSK_PRIOR_3, &task3_handle)     != pdPASS){
                /*!< FreeRTOS xTaskCreate() API function */
                EMBARC_PRINTF("Create task3 Failed\r\n");
                return -1;
        } else {
                EMBARC_PRINTF("Create task3 Successfully\r\n");
        }

        // Create Semaphores
        sem1_id = xSemaphoreCreateBinary();
        xSemaphoreGive(sem1_id);

        // Create Queues
        dtq1_id = xQueueCreate(8, sizeof(uint32_t));

        xTaskResumeAll();
        vTaskSuspend(NULL);

        return 0;
}

static void task1(void *par)
{
        uint32_t led_val = 0;

        static portTickType xLastWakeTime;
        const portTickType xFrequency = pdMS_TO_TICKS(10);

        // Use current time to init xLastWakeTime, mind the difference with vTaskDelay()
        xLastWakeTime = xTaskGetTickCount();

        while (1) {
                /* call Freertos system function for 10ms delay */
                vTaskDelayUntil( &xLastWakeTime,xFrequency );

                //####Insert code here###
        }
}

static void task2(void *par)
{
        uint32_t led_val = 0x0001;

        static portTickType xLastWakeTime;
        const portTickType xFrequency = pdMS_TO_TICKS(100);

        // Use current time to init xLastWakeTime, mind the difference with vTaskDelay()
        xLastWakeTime = xTaskGetTickCount();

        while (1) {
                /* call Freertos system function for 100ms delay */
                vTaskDelayUntil( &xLastWakeTime,xFrequency );

                //####Insert code here###
        }
}

static void task3(void *par)
{
        uint32_t led_val = 0;

        static portTickType xLastWakeTime;
        const portTickType xFrequency = pdMS_TO_TICKS(200);

        // Use current time to init xLastWakeTime, mind the difference with vTaskDelay()
        xLastWakeTime = xTaskGetTickCount();

        while (1) {
                /* call Freertos system function for 100ms delay */
                vTaskDelayUntil( &xLastWakeTime,xFrequency );

                //####Insert code here###
        }
}








Steps


Build and run the uncompleted code

The code is at embarc_osp/arc_labs/labs/lab9_freertos, uses an UART terminal console and run the code, the following message from program is displayed:

embARC Build Time: Mar  9 2018, 17:57:50
Compiler Version: Metaware, 4.2.1 Compatible Clang 4.0.1 (branches/release_40)
Create task1 Successfully
Create task2 Successfully
Create task3 Successfully





This message implies that three tasks are working correctly.



Implement task 3

It is required for task 3 to retrieve new value from the queue and assign the value to led_val. The LED controls are already implemented in previous labs, the new function to learn is xQueueReceive(). This is a FreeRTOS API to pop and read an item from queue. See FreeRTOS documentation and complete the code for this task. (An example is in ‘complete’ folder)



Implement task 1

It is required for task 1 to check if value from queue is legal. If not, a reset signal is needed to be sent.

Two new functions might be helpful for this task: xSemaphoreGive() for release a signal and xQueuePeek() for read item but not pop from a queue. See FreeRTOS documentation and complete the code for this task. (An example is in ‘complete’ folder)

Do notice the difference between xQueueReceive() and xQueuePeek().



Implement task 2

There are two different works for task 2 to complete: to shift led_val and queue it, and to reset both led_val and queue when illegal led_val is detected.

Three functions can be helpful: xQueueSend(), xSemaphoreTake(), xQueueReset(). See FreeRTOS documentation and complete the code for this task. (An example is in ‘complete’ folder)



Build and run the completed code

Build the completed program and debug it to fulfill all requirements. (8-digit running LEDs are used in example code)




Exercises

The problem of philosophers having meal:

Five philosophers sitting at a round dining table. Suppose they are either thinking or eating, but they cannot do these two things at the same time. So each time when they are having food, they stop thinking and vice-versa. There are five forks on the table for eating noddle, each fork is placed between two adjacent philosophers. It is hard to eat noodles with one fork, so all philosophers need two forks in order to eat.

Write a program with proper console output to simulate this process.
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ARC DSP: Compiler Optimizations


Purpose


	To understand Metaware compiler DSP extension options and optimization level


	To learn how to use Metaware compiler to optimize regular C code with DSP instructions






Requirements

The following hardware and tools are required:


	PC host


	MetaWare Development Toolkit


	ARC board (EM Starter Kit / IoT Development Kit)


	embarc_osp/arc_labs/labs/dsp_lab_compiler_opt






Content

An example code below contains a function “test” which contains a 20 step for loop and a multiply accumulate operation done manually.

#include <stdio.h>

short test(short *a, short *b) {
    int i;

    long acc = 0;
    for(i = 0; i < 10; i++)
            acc += ( ((long)(*a++)) * *b++) <<1 ;

    return (short) (acc);
}

short a[] = {1,2,3,4,5, 6,7,8,9,10};
short b[] = {11,12,13,14,15, 16,17,18,19,20};

int main(int argc, char *argv[]) {

    short c = test(a,b);

    printf("result=%d",c);

    return 0;
}





Use Metaware compiler to optimize the C code with and without DSP extension options, and analyze the assembly code.



Principles

This section describes compiler options in MetaWare used in this lab.

To optimize code with DSP extensions, two sets of compiler options are used throughout the lab: DSP Extensions options and optimization level.


DSP Extensions Options

Use embARC OSP build system to compile the code. The details can be found in embARC OSP document page. Here is the example command. You can pass extra compiler/liner options by ADT_COPT/ADT_LOPT.

gmake BOARD=iotdk BD_VER=10 CUR_CORE=arcem9d TOOLCHAIN=mw ADT_COPT="-Hfxapi -Xdsp2" OLEVEL=O2





Options that are used in the lab are:


	-Xdsp[1/2]:

Enable DSP instructions



	-Xdsp_complex, -Xdsp_divsqrt:

Enable complex arithmetic DSP, divide, and sqrt instructions



	-Xdsp_ctrl[=up|convergent,noguard|guard, preshift|postshift]:

Fine-tune the compiler’s assumptions about the rounding, guard-bit, and fractional product shift behavior



	-Hdsplib: Link in the DSP library

For programming ARC fixed-point DSP in C and C++

Contains functions to carry out DSP algorithms such as filtering and transforms



	-Hfxapi: Use the Fixed Point API support library

Used with -Xdsp. Provides low level intrinsic support for ARC EM DSP instructions

Programs written using this API execute natively on an ARC EM processor with DSP extensions and can also be emulated on x86 Windows hosts



	-Xxy: Specifies that XY memory is available

Used with -Xdsp2. Enables optimization for XY memory



	-Xagu_small, -Xagu_medium, -Xagu_large:

Enables AGU, and specifies its size






Note

Because ARC is configurable processor, different cores can contain different extensions on hardware level. Therefore, options set for compiler should match underlying hardware. On the other hand, if specific hardware feature is present in the core but compiler option is not set, it cannot be used effectively, if used at all. IOTDK Core default options are presented in tcf file.


  
    

    ARC DSP: Using FXAPI
    

    

    
 
  

    
      
          
            
  
ARC DSP: Using FXAPI


Purpose


	To understand what is ARC Fixed-point API (FXAPI)


	To learn how to use FXAPI to optimize DSP programs






Requirements

The following hardware and tools are required:


	PC host


	MetaWare Development Toolkit


	ARC board (EM Starter Kit / IoT Development Kit)


	embarc_osp/arc_labs/labs/dsp_lab_fxapi






Content

This lab uses complex number multiplication as an example where using just compiler optimization options cannot gain the same effect as calling DSP instructions manually through FXAPI.



Principle

In this lab two implementations of complex multiplication are shown with and without FXAPI.


Complex number multiplication

Multiplication of two complex numbers
[image: dsp_icon_2.1]
and
[image: dsp_icon_2.2]

Is done using formula:

[image: dsp_icon_2.3]

In this lab example multiplication and accumulation of two arrays of complex numbers are used as a way to compare performance of ARC DSP extensions when used effectively.

The sum of element wise products of two arrays of complex numbers is calculated according to the following formula:

[image: dsp_icon_2.4]

where a and b are arrays of N complex numbers.



Implementation without DSP

In order to calculate element wise products of two arrays of complex numbers, a struct can be defined that stores real and imaginary parts of the complex number. Therefore, the calculation process receives an array of structures and works on it. The code is shown below:

typedef struct { short real; short imag; } complex_short;

complex_short short_complex_array_mult (complex_short *a, complex_short *b, int size) {
    complex_short result = {0,0};
    int acci=0;
    int accr=0;

    for (int i=0; i < size; i++) {
            accr  += (int) ( a[i].real * b[i].real );
            accr  -= (int) ( a[i].imag * b[i].imag );

            acci  += (int) ( a[i].real * b[i].imag );
            acci  += (int) ( a[i].imag * b[i].real );
    }

    result.real = (short) accr;
    result.imag = (short) acci;

    return result;
}





The example keeps real and imaginary values in variables of type “short”, while multiplication results are kept in “int” integer to avoid truncation. Final result is casted to short to return complex number as a result.



Implementation with FXAPI

FXAPI makes it possible to directly access complex number instructions (like MAC) available in ARC DSP Extensions. This is done through complex number type cq15_t, and various fx_* functions. Here fx_v2a40_cmac_cq15 FXAPI function is called which performs MAC of two cq15_t complex numbers.

cq15_t fx_complex_array_mult(cq15_t *a, cq15_t *b, int size) {
    v2accum40_t acc = { 0, 0 };

    for (int i=0; i < size; i++) {
       acc = fx_v2a40_cmac_cq15(acc, *a++, *b++);
    }

    return fx_cq15_cast_v2a40( acc );
}





As with previous implementation q15_t is of similar size as short type, therefore, multiplication result needs larger storage. Here 40b vector accumulator is used directly to store intermediate results of MAC, and is casted to cq15_t on return.



Using IoT Development Kit board for performance comparison

To compare performance of these two functions a simple application is created that performs complex array multiplication using either of the implementations above. The program initializes two arrays of complex numbers with random values and calls functions above in a loop (1 000 000-10 000 000 times) to make calculation delay measurable in seconds. This is done eight times, and after each loop a LED on board turns-on. In the result, LED strip on board works as a “progress bar” showing the process of looped multiplications.

The main performance check loop is shown in the following example. The outer loop runs 8 times (number of LEDs on LED strip), the inner loop makes “LOOPS/8” calls to complex multiplication function. LOOPS variable is configurable to change the total delay.




Steps

To test the following example, some modification of the code is required to have two loops with and without DSP.

Firstly you must build DSP libraries for this particular configuration of IOTDK:

buildlib my_dsp -tcf=<IOTDK tcf file> -bd ../ -f

IoT Development Kit tcf file can be found in embarc_osp/board/iotdk/configs/10/tcf/arcem9d.tcf

Both examples are to be compiled with DSP extensions.


1. Run program without FXAPI

Build with the command:

gmake BOARD=iotdk BD_VER=10 CUR_CORE=arcem9d TOOLCHAIN=mw gui ADT_COPT="-Hdsplib" ADT_LOPT="-Hdsplib -Hlib=../my_dsp"

With high optimization level functions using “short” type is compiled to use DSP MAC operation, enabling significant speedup.

[image: dsp_figure_2.1]



2. Run program with FXAPI

Rename main.c.fxapi to main.c, then execute the command:

gmake BOARD=iotdk BD_VER=10 CUR_CORE=arcem9d TOOLCHAIN=mw gui ADT_COPT="-Hdsplib" ADT_LOPT="-Hdsplib -Hlib=../my_dsp"

However, using FXAPI enables compiler to directly use complex MAC instruction “cmachfr”.

[image: dsp_figure_2.2]
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ARC DSP: Using DSP Library


Purpose


	To understand what is ARC DSP library


	To learn how to use DSP library to optimize DSP programs






Requirements

The following hardware and tools are required:


	PC host


	MetaWare Development Toolkit


	ARC board (EM Starter Kit / IoT Development Kit)


	embarc_osp/arc_labs/labs/dsp_lab_dsp_lib






Content

This lab uses matrix multiplication as an example where DSP library helps to efficiently use DSP extensions with shorter code.
To use DSP Library and compare the execution speed of the programs with and without DSP library.



Principle

In this lab two implementations of matrix multiplication are shown:
One manual implementation and the other using the DSP library.


Matrix multiplication

Multiplication of two matrices A and B of sizes [M*N] and [N*K] respectively is implemented using the following formula:

[image: dsp_icon_3.1]

Where i= 0…(M-1) and j = 0..(K-1) are row and column indexes of output matrix, with size [M*K].



Implementation without DSP

The following example shows the implementation of matrix multiplication of two matrices containing “short” values. By convention, matrices here are implemented as 1D arrays with row-first indexing, where element a_ik is indexed as
[image: dsp_icon_3.2]

#include "embARC.h"
#include "embARC_debug.h"
#include <stdlib.h>

#define MATRIX_SIZE 20
#define MAX_NUM 1000
#define LOOPS 100000

/* ********************************************* */

/* Matrix manipulation functions */

/* randomize matrix with values up to 'max_value */
void rand_sq_mat(short x[][MATRIX_SIZE], int SIZE, int max_value) ;

/* multiply two square matrices of same size*/
void mul_sq_mat(short x[][MATRIX_SIZE], short y[][MATRIX_SIZE], short z[][MATRIX_SIZE], int size) ;

/* print square matrix through UART*/
void print_sq_mat(short x[][MATRIX_SIZE], int SIZE);

/* ********************************************* */

int main(int argc, char *argv[]) {

    short a[MATRIX_SIZE][MATRIX_SIZE];
    short b[MATRIX_SIZE][MATRIX_SIZE];
    short c[MATRIX_SIZE][MATRIX_SIZE];
    int n =MATRIX_SIZE;

    rand_sq_mat(a,n, MAX_NUM);
    rand_sq_mat(b,n, MAX_NUM);

    print_sq_mat(a,n);
    print_sq_mat(b,n);

    unsigned int led_status = 0x40 ;
    led_status = 0x7F;

    EMBARC_PRINTF("*** Start ***\n\r");

    for (int i =0; i< 8; i++) {
            for (int j = 1; j < LOOPS/8; j++ ) {
                    mul_sq_mat(a,b,c,n);
            };
            led_write(led_status, BOARD_LED_MASK);
            led_status = led_status >> 1;
    }

    print_sq_mat(c,n);

    EMBARC_PRINTF("*** Exit ***\n\r");

    return 0;
}



void rand_sq_mat(short x[][MATRIX_SIZE], int SIZE, int max_value) {
    for (int i=0;i<SIZE;i++) {
            for(int j=0;j<SIZE;j++) {
                    x[i][j] = 1 + (rand() % max_value); //plus 1 to avoid zeros
            }
    }
}

void mul_sq_mat(short x[][MATRIX_SIZE],short y[][MATRIX_SIZE], short z[][MATRIX_SIZE], int size) {
    for (int i=0; i<size; i++) {
            for(int j=0;j<size;j++) {
                    z[i][j]=0;
                    for(int k=0;k<size;k++) {
                            z[i][j] += x[i][k]*y[k][j];
                    }
            }
    }
}

void print_sq_mat(short x[MATRIX_SIZE][MATRIX_SIZE], int SIZE){

    EMBARC_PRINTF("------\n\r");

    for(int j = 0; j < SIZE; j++ ){
        for(int i = 0; i < SIZE; i ++){
            EMBARC_PRINTF("%d\t", x[j][i]);
        }
        EMBARC_PRINTF("\n\r" );
    }

    EMBARC_PRINTF("------\n\r");
}







Implementation with DSPLIB

DSP library contains matrix multiplication function, implementing matrix multiplication using DSP library requires initialization of matrix arrays (1D) and call to dsp_mat_mult_q15. The overall code is 4 lines, as highlighted in the following code. Note that dsplib.h must be included, and matrix a, b, and c must be declared as global variable. As the numbers are in q15 type, it is better to make elements of a and b between 32767 (~0.99) and 16384 (0.5), or 32768(-1) and 49152 (-0.5) that the result in c is not rounded to zero. Note as IOTDK is configured to have small AGU, the DSP library routine is not significantly faster.

#include "embARC.h"
#include "embARC_debug.h"
#include <stdlib.h>
#include "dsplib.h"

#define MATRIX_SIZE 20
#define MAX_NUM 1000
#define LOOPS 100000

/* ********************************************* */

/* Matrix manipulation functions */

/* randomize matrix with values up to 'max_value */
//void rand_sq_mat(short x[][MATRIX_SIZE], int SIZE, int max_value) ;

/* multiply two square matrices of same size*/
void mul_sq_mat(short x[][MATRIX_SIZE], short y[][MATRIX_SIZE], short z[][MATRIX_SIZE], int size) ;

/* print square matrix through UART*/
void print_sq_mat(short* x, int SIZE);

/* ********************************************* */
    __xy q15_t a[MATRIX_SIZE*MATRIX_SIZE];
    __xy q15_t b[MATRIX_SIZE*MATRIX_SIZE];
    __xy q15_t c[MATRIX_SIZE*MATRIX_SIZE];

int main(int argc, char *argv[]) {

    int n =MATRIX_SIZE;
matrix_q15_t matA, matB, matC;

    //rand_sq_mat(a,n, MAX_NUM);
    //rand_sq_mat(b,n, MAX_NUM);
    for (int i =0; i< MATRIX_SIZE*MATRIX_SIZE; i++) { a[i]=16384; }
    for (int i =0; i< MATRIX_SIZE*MATRIX_SIZE; i++) { b[i]=16383; }


    print_sq_mat(a,n);
    print_sq_mat(b,n);

dsp_mat_init_q15(&matA,  MATRIX_SIZE, MATRIX_SIZE, a);
dsp_mat_init_q15(&matB,  MATRIX_SIZE, MATRIX_SIZE, b);
dsp_mat_init_q15(&matC,  MATRIX_SIZE, MATRIX_SIZE, c);
dsp_status status;

    unsigned int led_status = 0x40 ;
    led_status = 0x7F;

    EMBARC_PRINTF("*** Start ***\n\r");

    for (int i =0; i< 8; i++) {
            for (int j = 1; j < LOOPS/8; j++ ) {
                    status = dsp_mat_mult_q15(&matA, &matB, &matC);
            };
            led_write(led_status, BOARD_LED_MASK);
            led_status = led_status >> 1;
    }

    if ( status == DSP_ERR_OK ) EMBARC_PRINTF("done\n");
    else EMBARC_PRINTF("something wrong");
    print_sq_mat(c,n);

    EMBARC_PRINTF("*** Exit ***\n\r");

    return 0;
}



//void rand_sq_mat(short x[][MATRIX_SIZE], int SIZE, int max_value) {
//  for (int i=0;i<SIZE;i++) {
//          for(int j=0;j<SIZE;j++) {
//                  x[i][j] = 1 + (rand() % max_value); //plus 1 to avoid zeros
//          }
//  }
//}
//
//void mul_sq_mat(short x[][MATRIX_SIZE],short y[][MATRIX_SIZE], short z[][MATRIX_SIZE], int size) {
//  for (int i=0; i<size; i++) {
//          for(int j=0;j<size;j++) {
//                  z[i][j]=0;
//                  for(int k=0;k<size;k++) {
//                          z[i][j] += x[i][k]*y[k][j];
//                  }
//          }
//  }
//}

void print_sq_mat(short* 